
pH-MultiScan ver. 6.0.2 

November 28, 2022 

 
Improvements 

A new export option for function data based on generated smoothed line series has 

been added. The corresponding menu item is found here: 

“File\Export options\Fn smoothed…”. 
 

Fixed errors 

 

1) Missing clearing of old chart series  

 Selected series from a previous scan session should be automatically cleared, 

when a new scan session is started. It did not happen, until new series were 

selected (checked). 

   

  Switch between chart and data window  

 When new data was loaded, while the chart window was open, the chart win-

dow should remain displayed, but instead the program switched to the Fn data 

window. 

 

Plans for ver. 6.0.3 

 

1) Data recalculation 

Scanned raw data will be saved internally in pH-MultiScan to enable recalcula-

tion of Fn and HLC/RGB data. This will make it possible to fine tune the cali-

brated polynomium. 

 

2) Printed charts 

Printed chart’s measurements will unlike now be independent of the actual 

monitors resolution (dpi).   

 

 

 

 

 

 

  



pH-MultiScan ver. 6.0.1 

September 26, 2022 

 
Improvements 

New options have been added to the chart. 

 

2) Print Chart 

To print a chart: Right-click the chart and select “print chart” in the right-click 

menu. A preview window appears, from which a printer can be selected, and 

appropriate settings can be made. Finally press “Print”. 

Note: Setting the printer to overlay print may in some cases cause the applica-

tion to freeze. 

 

3) Smoothed line series 

 “Raw data series”, “Smoothed series” or “Raw and smoothed series” are now 

optional in the chart’s right-click menu. 

 Line smoothing is carried out using polynomial curve fitting. The polynomial or-

der can either be adjusted automatically to ≤ 10 depending on the number of 

data points, or manually to a max of 20. These settings are available in the 

“Tools\Settings\Chart…\Line smoothing” window. 

 

4) Enhanced visibility 

 To enhance the visibility of bold series, non-bold series can be faded by clicking 

“Fade hairline series” in the right-click menu. The series can similarly be un-

faded again. 

 

5) Legend scrollbar 

 A scrollbar will now appear to the right of the chart legend, if the legend ex-

ceeds the chart’s height. 

 

Fixed errors 

 

2) Additional data output 

 The default folder for “Additional data output” is “C:\ProgramData\pH-Multi-

Scan\OptionalOutput”, but it became wrongly registered as “C:\pH-Multi-

Scan\OptionalOutput”. Consequently an error message occurred, when the ap-

plication attempted to access the folder. 

   

3) Before connecting the first scanner  

 If no scanner had ever been connected to pH-MultiScan, an error occurred at 

start-up, and the application closed.  

 Now a missing scanner connection message occurs, and the application will 

continue with limited operating options.  

 

4) Minor errors have been fixed 

 

  



  

pH-MultiScan ver. 5.3.1 

Marts 30, 2021 

 
Improvements 

 

1) The “Method settings” window’s toolbar/menubar and the “Show report” win-

dow’s toolbar have been reorganized and simplified. 

 

2) In the “Show report” window the report can now be saved as a PDF document 
in the current scanners fixed method folder. The fixed method file name con-

tains the needed information including latest file update date and time.   

 

3) In the “Error log” window the error log can now be printed (directly to the de-

fault printer), and furthermore saved as a PDF document in a folder of choice.  

The log content can now be cleared (permanently!) to get rid of outdated con-

tent related to already fixed errors. 

4) As the “Method settings” and the “Error log” now can be saved in the universal 

PDF format, and easily can be mailed to HNH Consult from any mail application 

when needed, the - in certain cases incompatible - e-mail option directly from 

pH-MultiScan has been removed. 

 

Fixed errors 

 

1) Old method files created before ver. 5.1.1 had a compatibility issue compared 

to later versions, causing an unpredictable save destination for additional out-

put data. 

   

2) Long scan sessions (> 546 hours) caused an overflow error. Now there is no 

practical time limit. 

 

3) Changing a scanner name or alias and thereby changing the scanner main 

folder name did not correct the additional data output folder path correspond-

ingly, when the additional data output folder was placed as a subfolder to the 

scanner main folder.  

 

5) Measures has been taken for enhanced error handling. 

 

6) Minor errors have been fixed. 

 

 

 

  



pH-MultiScan ver. 5.3.0 

January 22, 2020 

 
Improvements 

 

7) User interface 

In general, pH-MultiScan’s user interface has got a more consistent look and 

feel with new menu- and toolbar icons and a number of other enhancements.  

 

Fixed errors 

 

1) Minor errors have been fixed.  

 

 
  



pH-MultiScan ver. 5.2.2 

July 23, 2019 

 
Improvements 

 

1) User interface 

 The “Settings” tab pages “Scan”, “Dimensions” and “Page size” has been slightly 

revised to facilitate more intuitive settings adjustments. 

 

 
  



pH-MultiScan ver. 5.2.1 

April 30, 2019 

 
Fixed errors 

 

1) Identification error 

 Under certain circumstances an identification error dialog box as shown below 

occurred. After pressing OK, the application was closed. 

  

 

 

  



pH-MultiScan ver. 5.2.0 

March 20, 2019 

 
License information 

An unlimited number of pH-MultiScan installations within the Chr Hansen A/S or-

ganisation are now allowed. The security dongles are now replaced by a supplied 

password, which will be renewed with each new program version. 

Derived changes in the setup procedure have been implemented. 

 
Fixed errors 

 

1) Reappearing scanner error pop-up message 

 Under certain circumstances a system error pop-up message appeared, after 

starting a scan session, if the scanner was not detected by the system, and the 

pop-up message repeatedly appeared, after it was closed by pressing “OK”. 
 

Improvements 

 

1) Added index column 

 An index column has been inserted into the “Recent scan” .xls/.txt output data. 

 

2) Minor error tracking improvements have been implemented. 

 

 

  



pH-MultiScan ver. 5.1.6 

July 25, 2018 

 
Fixed errors 

 

1) Misplaced "Try" button 

 In previous versions, the "Try" button (in method settings window) appeared 

across all 5 tab pages. Now the button is visible only on the relevant "Dimen-

sions" page. 

 

2) Initial disabled controls 

 After installing and opening pH-MultiScan for the very first time on a new com-

puter, most controls in the "Settings" and the "Scanner shortcut manager" win-

dows were disabled (like they are during scanning). After closing and reopening 

the program the problem permanently went away. 

 Now all controls will be enabled right from the beginning. 

 
Improvements 

 

1) Highlighting line graphs 

 In previous versions multible concurrent "Fn(time)" line graphs could be difficult 

to distinguish from each other. Now a new option to highlight one or more se-

lected line graphs has been implemented. 

  How to... 

  Left click on a checked "Fn" row in the row's fixed (gray) area, and the gray 

background will turn yellow. The associated "Fn(time)" graph is now high-

lighted to stand out from the rest. Multible line graphs can be highlighted 

one by one. 

  Left click the highlighted fixed row area again to cancel the graph highlight. 

  Right click anywhere in the fixed area to cancel all graph highlights.  

  

 

2) Copy/past/delete "Name" cells 

 Two different ways to perform Copy/past/delete actions has been implemented. 

  A convenient way to copy a single name to one or more destinations 

  Copy:  Left click on a "Name" cell to copy its content. 

  Paste:  a) Press and hold the "Alt" key. 

 b)  Left click on the destination cell to paste. 

  Or press and hold left mouse button and draw the mouse across 

multiple cells to paste. 

  Delete:  a) Select rows containing "Name" cells to delete. 

   b) Press and hold the "Alt" key. 

 c) Right click anywhere inside the "Name" column to delete se-

lected names. 

   

  



How to copy block(s) of names to new destinations  

  Copy: a) Select the desired block(s) of rows. 

   b) Right click anywhere inside the "Name" column. 

   c) Select "Copy" in the popup menu. 

  Paste: a) Right click on the topmost destination cell. 

   b) Select "Paste" in the popup menu. 

  Delete: a) Select the desired block(s) of rows. 

   b) Right click anywhere inside the "Name" column. 

   c) Select "Delete" in the popup menu. 

 

3) Check/uncheck multible checkboxes  

 Check/uncheck multiple checkboxes works much the same way as in previous 

versions, but there are three exceptions as described below. 

 1)  The Alt + draw action must start within the checkbox column. 

 2)  The "Shift" and "Ctrl" buttons are no longer needed to draw checkmarks 

across different not coherent blocks. 

 3)  To uncheck checkboxes in selected rows using "Alt" + right click, the mouse 

must be clicked within the borders of the checkbox column (to distinguish 

between deleting names or unchecking checkboxes). 

   

 
  



pH-MultiScan ver. 5.1.5 
 
Fixed errors: 

 

1) Attempts to "Cascade", "Tile horizontally" or "Tile Vertically" from the "Win-

dows" menu, caused an error message followed by an application shut down.  

 

2) The "Fn..." export option was missing in the "File" → "Export options" menu. 

 

3) Textbox tab order in method settings window have been adjusted to an ex-

pected behaviour when using the keyboard's TAB button. 

 

4)  If no scanner had ever been connected to a pH-MultiScan computer, an error 

message followed by an application shut down occurred after an attempt to 

save or cancel a method (with no scanner relation).  

 A message to connect a scanner will now pop up, and the application will stay 

open. 

 
 

  



pH-MultiScan ver. 5.1.4 
 
Fixed errors: 

 

1) After scanning, all polynomial textboxes were disabled, when the 10 terms poly-

nomial option were selected in method settings.  

 

 

  



pH-MultiScan ver. 5.1.3 
 
Fixed errors: 

 

1) pH-MultiScan 5.1.2 did not save any selected HLC "Additional data output" 

at all. Additional RGB data  

2) output were unaffected by this error.  

 
 

  



pH-MultiScan ver. 5.1.2 
 
Fixed errors: 

 

1) After saving a method under a new name, the previous method was loaded af-

ter an application restart. 

 
Improvements: 

 

1) The method settings in pH-MultiScan 5.1.2 now include two calculation options 

based on either 6 or 10 term polynomials. The setup page under the "Polyno-

mial" tab reflects the actual choice made under the "Scan" tab. 

 Both color space and number of polynomial terms are added to the scan method 

report. 

  

2) In previous versions of pH-MultiScan, the user was always asked "Overwrite 

current method" after pressing "OK" in the settings window, even if no changes 

were made. 

 Now the user is asked "Save changes" only if changes are made. If the user 

needs to save the method under a new name, a new "Save as..." option has 

been added to the settings window's "File" menu. 

 

3) A few minor cosmetic improvements have been made, including a more appro-

priate report view icon in the settings window. 

 

 
  



pH-MultiScan ver. 5.1.1 
 
Improvements: 

 

1) The method settings in pH-MultiScan ver. 5.1.1 now include a choice between 

two color space options, and the application can now output either HCL or RGB 

data.   

  



pH-MultiScan ver. 5.1.0 
 
Service information: 

 

1) pH-MultiScan ver. 5.1 will install in the new folder  

 "C:\Program Files (x86)\pH-MultiScan 5.1" 

 and leave the previous program version 5.0 untouched in 

 "C:\Program Files (x86)\pH-MultiScan 5.0".  

 Both versions can coexist and share the same settings for each connected scan-

ner. 

 For the scanner shortcut icons (on the desktop) to know which program version 

they are linked to: just open the "Scanner Shortcut Manager" and click "OK". 

The shortcuts are now linked to the selected program version. 

  

 

2) Uninstalling the previous program ver. 5.0.x do not remove the "C:\Program 

Files (x86)\pH-MultiScan 5.0" program folder and its subfolder (including a sin-

gle file), but it is safe to remove them manually. They will do no harm if not re-

moved. 

 When uninstalling the new version 5.1, its own program folders with content will 

be correctly removed.    

 
Fixed errors: 

 

1) Trying to start a scan session with a scanner not connected or turned off caused 

an error 20082 (No data source) to be written in the error log followed by an 

unintended program shut down. 

 Now the program will stay open, handle the error in a more "clean" way and re-

set itself. A message will tell which scanner is disconnected or turned off, and 

no error will be written in the error log. 

 

 

  



pH-MultiScan ver. 5.0.10 
 
Fixed errors: 

 

1) On the method settings print preview page, the polynomium part was misplaced 

caused by an unintended program code deletion in version 5.0.9. 

 

2) Position adjustments of the scanned circular spots using the "Try" button caused 

an unintended position data exchange between open instances of pH-MultiScan. 

Now these data remain local and scanner specific. 

3) In the method open/save file dialog box, the "Parent folder" and "Create new 

folder" were always enabled. They should always be disabled. 

 

4) The "Try" button in the "Settings" window was enabled while scanning. It should 

be disabled. 

 

5) The scanned picture from the most recent scan should disappear when previous 

data was opened. The error has been fixed 

 

Improvements: 

 

1) For improved error identification, a new operating system (OS) column has 

been added to the ErrorLog.  

 The OS-column contains OS-name, OS-architecture (32 or 64 bit), OS-version 

number and OS service pack number (if any). 

 

2) It is no longer necessary to uninstall an old program version before reinstalling 

an equivalent or a new version. 

 Installing an old version over a new one is still not allowed, but requires a prior 

uninstall! 

 

 
  



pH-MultiScan ver. 5.0.9 
 
Service information: 

 

pH-MultiScan ver. 5.0.9 has been tested in the Windows 10 environment, and so 

far no issues have been encountered. 

 

Fixed errors: 

 

1) Attempts to export a chart to an already open pdf-file, raised an error no. 

  -2147418113 followed by a "soft" program exit.  

 Now the error is handled with a more meaningful message, and the program 

stays open. 

 

2) Opening a new project over an already opened and changed project will prompt 

the user to save the changes before opening, but in this particular case an 

"Open" (not a "Save) file dialog was shown by mistake. 

 

3) The "Size +/-" input options in the "Settings" window under the "Adjustment" 

tab has been removed. They were unnecessary and not working survivals from 

the very beginning of the pH-MultiScan age.  

 

Improvements: 

 

1) In previous scanned images each defined circular spot's varying pixel colours 

were transformed to a mean colour. Now the mean colour has been replaced by 

a median colour to reduce misinterpretations caused by eccentric spots.  

 

2) To ensure that the defined, circular spots are properly centered to the "wells", 

the magnifying glass tool has become more straightforward to use in this ver-

sion. Now it is solely operated by the mouse, and thus removed from the Tool's 

menu.  

 Operation instructions for the updated magnifying glass: 

 a)  Left-click on the image to enter magnifying mode (a magnifying glass curser 

appears). 

 b)  While in magnifying mode: Left-click and hold to magnify the area under the 

curser. Release the button to stop magnifying. Repeat left-click and hold and 

release as needed. 

 c)  Right-click to leave magnifying mode (the normal curser reappears) 

 

3)  When positioning the circular spots in an image, it can be difficult visually to 

distinguish the spot areas from their surroundings. A new and simple to use 

"spotlight" tool has solved this issue. It works like this: 

 a) Right-click the image to turn the "spotlight" on (when not in magnifying 

mode). 

 b) Right-click the image again to turn the "spotlight" off. 

 

4) A "Try" button has been placed in the lower right corner of the "Settings" win-

dow. Pressing the button will immediately show the effect of any position 

changes made by the user. I.e. the spots will move to the desired position and 



the "spotlight" will be turned on. For further convenience, the magnifying glass 

can now be operated while the "Settings" window is open. 

  New spot positions can finally be saved or cancelled as usual with the "OK" or 

"Cancel" buttons. 

 

5) The toolbar's scan button is now divided into two and has an additional test 

scan option. Test scans are intended for adjustment purposes only, and no data 

will be saved during scanning. 

 

 
  



pH-MultiScan ver. 5.0.8 
 
Fixed errors: 

 

1) Twain scanner communication stability has been improved. 

 

 

  



pH-MultiScan ver. 5.0.7 
 
Fixed errors: 

 

1) The "Known issues" in pH-MultiScan ver. 5.0.6 has been resolved. 

 

Improvements: 

 

1) A new option to save "Recent scan only" and/or "All scans" has been added to 

the "Additional data output" window.  

 

  



pH-MultiScan ver. 5.0.6 
 
Improvements: 

 

1) An availability check for the scanner is now carried out before each single scan. 

In earlier program versions that happened at scan session start only.  

 Attempts to start scanning with an unavailable scanner are now handled in a 

more appropriate way by the program, supported by meaningful text messages. 

 

Known issues: 

 

1) The HP Scanjet G4050 will default go into standby mode if inactive for less than 

half an hour or so, and the button on the scanner lid starts blinking.  

 After some hours the standby state seem to change to hibernation state (deeper 

sleep), and this can cause pH-MultiScan to "freeze", when it wakes the scanner 

and the first scan has been performed. This problem will not occur in the initial 

standby period.  

 Until this problem is addressed, a successful work around can be made by 

changing the scanners default settings in the installed HP provided scanner soft-

ware to shut down the scanner after 1 hour of inactivity. This will prevent the 

scanner from reaching the hibernation state. 

  



pH-MultiScan ver. 5.0.5 
 
Fixed errors: 

 

1) During program installation, a detailed install log should be written in the folder 

"C:\Windows\pH-MultiScan\SetupLog.txt". Caused by a path error, the log file 

writing failed. 

 This issue has no influence on program execution in general, but is an important 

installation error tracking tool. 

 

 

  



pH-MultiScan ver. 5.0.4 
 
Fixed errors: 

 

1) A few errors related to first time execution of pH-MultiScan on a new computer 

before any scanner had been attached have been fixed. 

 

2) The distance between vertical or horizontal holes in sample plates were inter-

nally handled as integer values causing 1 mm accumulated jumps, even if deci-

mal values were input.  

 

Known issues: 

 

1) An error "Invalid procedure call or argument" (error no. 5) has arisen once dur-

ing the test period, and has so far not been possible to track. Some tracking 

measures have been taken in the actual procedure to provide more specific er-

ror information in the error log, when the error arises again. Please let us know 

when that happens. 

  



pH-MultiScan ver. 5.0.3 
 
Fixed errors:  

 

1) Method files written in version 5 were not fully backwards compatible causing 

extreme Fn results when used in version 4.1.  

 

2) Data in the first data column for each plate were displaced one step downwards. 

 

3) Gridlines in fixed areas were missing in excel data files. 

 

4) A "-" was missing in Excel and text file name of C-data. 

 

5) An ID-column has been inserted in Excel- and text data files as in version 4.1. 

 

6) The Checkbox column in the program's Fn-data appeared as an empty column 

in Excel. It has now been removed (in Excel only). 

 

7) Scanning, before a method file is defined by the user, causes the program to 

use its own default settings. Auto scan mode is such a default setting, but it was 

not recognized, causing the scan session to stop after only one scan. 

 

8) Windows 7 and 8.1 do no longer allow use of the root folder "C:\" as a data-

folder. pH-MultiScan will now hinder attempts to break this rule and inform the 

user by a message.  

 

Improvements: 

 

1) The error log can now be opened both from pH-MultiScan's Help menu and from 

the Windows' program's menu. "Save" and "E-mail" options has been imple-

mented directly into the error log viewer. 

 

 

  



pH-MultiScan ver. 5.0.0 
 

The new pH-MultiScan ver. 5.0 has been partly rewritten, and unused options have 

been exchanged with new improved and requested options, and efforts have been 

made to improve the user interface.  

 

New project file format 

The previous native Fn scan data file format "bin" has been replaced by a new pro-

ject data file format "prj".  

A project file contains both Fn, Hue, Light and Chroma data united in one com-

pressed data file, which is considerably smaller than the previous "bin" file. Bin-files 

and prj-files are not interchangeable. 

 

Save and export options 

When a project file has been opened in pH-MultiScan 5.0, both Fn, H, L and C-data 

will be present and available for further examination. A project can optionally be 

saved as a new custom project file or exported as separate Fn, H, L or C-data files 

in Excel or text format. All or a selected number of data rows can be saved or ex-

ported. Charts can be exported as pdf-files. 

  

Excel limitations 

Only 249 scans can be saved in the type of Excel files that pH-MultiScan can gener-

ate. Scans exceeding this limit will be chopped off with no errors. Text files have no 

practical upper limit and are thus preferable as export format for files containing 

more than 249 scans. Text files can easily be opened by Excel 2007 or later, which 

can handle up to 16384 columns.  

 

Scan output options 

After each scan, data are written to a pH-MultiScan project file (prj). Optionally the 

Fn, H, L and/or C-files can dynamically be saved either as tab separated text files 

or as Excel files while scanning. The file(s) can be saved in a preselected folder se-

lected in the "Data" → "Additional data output..." menu.  

If data are dynamically written to an Excel file, it can be opened temporarily for ex-

amination in Excel, but data cannot be written to the file, as long as it is opened by 

Excel. Anyway no collision will happen and no data will be lost. Just close the file 

and reopen it after the next scan, and it will be fully updated again. 

 

 

  



pH-MultiScan ver. 4.1.14 
 
Fixed errors:  

 

1) The distance between vertical or horizontal holes in sample plates were inter-

nally handled as integer values causing 1 mm accumulated jumps, even if deci-

mal values were input.     

 
 

  



pH-MultiScan ver. 4.1.13 
 
Fixed errors:  

 

1) Method files created in ver. 4.1 ond 5.1 were not fully compatible. 

 

 

  



pH-MultiScan ver. 4.1.12 
 
Improvements: 

 

Changes have been made to address some compatibility problems between pH-Mul-

tiScan ver. 5.0 and 4.1. 

Both versions can coexist and share common method settings, shortcut settings 

and main data folder, but native scan data files are not interchangeable between 

the two versions. 

 

 

  



pH-MultiScan ver. 4.1.11 
 
Fixed errors:  

 

1) The method settings window "froze" after opening/saving a method. The error 

was introduced in ver. 4.1.10. 

 

 

  



pH-MultiScan ver. 4.1.10 
 
Fixed errors:  

 

1) Saving scanned data as text (*.txt) or Excel (*.xls) data and then subsequently 

as native (*.bin) data, would cause an "Invalid procedure call or argument" er-

ror, no matter if the data were checked, selected, unselected, new or old.

  

 

 
  



pH-MultiScan ver. 4.1.7 – 4.1.9 
 
Fixed errors:  

 

1) pH-MultiScan would under certain circumstances loose contact with the security 

dongle, causing the program to get disconnected. 

 

 

  



pH-MultiScan ver. 4.1.6 
 
Fixed errors:  

 

1) Since the service pack 1 update of Windows 7, pH-MultiScan's cascading and 

tiled windows facility did not work at all on windows 7 systems. This issue did 

not affect Windows XP, Vista and earlier Windows 7 versions. 

 The problem has for now been partly fixed – i.e. as long as "Run this program 

as administrator" checkbox remain unchecked (on the program's property win-

dow's compatibility tab)! 

 The unchecked state is default for pH-MultiScan and prevents the "Will you al-

low..." window from appearing prior to each program execution (on Windows 

Vista and later systems). Thus this problem should not cause any inconven-

ience.  

 

Improvements: 

 

1) Windows Vista and Windows 7 will not (for security reasons) allow programs to 

write directly to data files in its program installation folder or subfolders like 

previous versions of pH-Multiscan did. Attempts to do so would not raise any er-

ror, as the data files were automatically redirected to a distant "...\Virtu-

alStore\..." folder by the system.  

 The program's data files are now written to the Microsoft recommended, system 

dependent "common application data folder" shown below: 

  

 Windows XP:  

 "C:\Documents and Settings\All Users\Application Data\pH-MultiScan" 

  

 Windows Vista and Windows 7: 

 "C:\ProgramData\pH-MultiScan" 

 

 pH-MultiScan ver. 4.1.6 will during installation automatically make the neces-

sary changes to ensure, that all settings will remain intact and appear as usual 

to the user. 

 NB: The scanned data will not be affected by the above mentioned changes. 

They will still be located in the same moveable folders as before. 

 
 

  



pH-MultiScan ver. 4.1.5 
 
Fixed errors:  

 

1) If the entire pH-Multiscan main data folder system accidentally was deleted, the 

program failed to recreate it during its start up control procedures, causing a 

"Path not found" error to occur.  

 

2) An attempt to open a FN datafile failed, if the file name extension was hidden by 

the Windows system. 

 

3) Fn(time) charts were not always properly scaled to fully exploit the vertical 

chart space. Now only 2% free space are left at both top and bottom.  

 

4) Previous program versions of pH-MultiScan would start minimized, if it had been 

minimized before program exit. 

 

5) It is no longer possible to rename folders and files in the file open/save dialog if 

the program is in "Restricted location" file mode.   

 

Improvements: 

 

1) Fn(time) line charts now show the graph names next to the mouse curser, when 

it crosses the graph line. 

 

2) Fn(time) chart's limit of showing 20 line graphs simultaneously has been raised 

to 256. 

 

3) The former primitive chart print option has now been replaced with a save op-

tion to save charts as vector based pdf files.  

 Pdf files can afterwards conveniently be viewed and printed on any connected 

printer in Adobe's Acrobat Reader. 

 The pdf files now show "FN-date-time-method" as main-header and "Scanned 

pH(time)" respectively "Corrected pH(time)" as sub-header. 

 

4) The "Tools" menu has been extended with a new "Options" item for: 

 a)  Changing page orientation of the future pdf chart files to be generated.  

 b) Choosing auto scaling or manual scaling of the Fn(time) chart's y-axis. 

 

5) Jaggy graph lines are now smoothened (antialiased). 

 

6) Fn binary files can now be saved in selected parts. A new "Save selection" check 

box has been added to the Fn "Save as" file dialog box. 

 

7) Selected rows can now be deselected by right clicking the mouse. This is useful 

to avoid a popup box prompting you to "Save selection only" or "Save all". 

 (The purpose of the popup box is to remind you, that selected rows exist but 

the "Save selection only" checkbox remains unchecked) 

 

  



8) Check marks for line graph activation can now be selected/deselected in exactly 

the same manner as rows, when the keyboard's "Alt" key is held down. I.e.:  

 Pressing the "Alt" key synchronize the row and check box selection.  

 Releasing the "Alt" key brings the row/check box selection back to normal. 

 
 

  



pH-MultiScan ver. 4.0.4 
 
Fixed errors:  

 

1) The open/save file dialog’s toolbar buttons “Parent folder” and “Go back” (in the 
dialog’s top right corner) did not behave correctly if the menu option ”Data” → 

“Custom Fn folder”→ ”Free location” was selected.  
 

2) On some systems, the program could not find the system’s “hand” mouse 
curser. Now the program uses its own hand curser. 

 

3) When the programs Fn view was chosen, the “Print” button was erroneous 
shown on the toolbar.  

 

Improvements: 

 

3) By choosing the data output format “Native + tab delimited text” or “Native + 
Excel” an exact copy of the saved binary output file’s content was automatically 
saved as a text or Excel file in the same folder as well. This reminiscence from 

very early versions of pH-MultiScan does not serve any purpose anymore and 

has been removed. By doing so the limitation of max 170 scans of 4 plates and 

227 scans of 3 plates has been raised to 251 scans of any number of plates. 

 Note! The optional generation of h, l and C output files into the scanners hlC 

map remains unaffected.  

 

 
  



pH-MultiScan ver. 4.0.3 
 

Fixed errors:  

 

1) Before the general file output format was set for the very first time, there was a 

mismatch between the default output format setting and the actual output for-

mat. 

 

2) If the program was minimized, when the scan session finished, it “froze”. 
 

3) The progress bar did under certain circumstances not reset itself before the next 

scan session was starting. 

 

4) The message box showed a wrong number of completed scans after a finished 

scan session. The correct number of scans was erroneous multiplied by the 

number of plates and thus incorrect, if more than one plate was selected. 

  

5) After opening the program and finishing the first scan in manual scan mode, the 

“Open”, “Save” and “Print” toolbar buttons remained disabled until the sidebar 

was activated to change the view forth and back again. 

 

Improvements: 

 

1) The general “Data” menu was misplaced in the scanner specific “Method set-

tings” form. It has now been moved to the main forms menu system, where it 

logically belongs. 

 

2) A new menu item “Custom Fn folder” containing the submenu options “Re-
stricted location” and “Free location” has been added to the “Data” menu. 

 The “Restricted location” (default setting) will restrict the Fn save location to the 

“Corrected Fn” standard folder exactly as in the previous program versions. 

 The new option “Free Location” will leave it to the user to decide where to save 

and open the native Fn data. The chosen locations are scanner specific and will 

be remembered by the program for each connected scanner.  

 

2) Now both file name textboxes in the “Save as” file dialog adjust their widths to 

the file dialog’s width. Before, only the right file name textbox could be ad-

justed. 

 

3) Some of the menu help text shown in the form’s footers has been improved. 

 

3) By choosing the output format “Native + tab delimited text” or “Native + Excel” 
a copy of the saved binary output file was after each scan saved in text or Excel 

format as well and in the same folder. This facility from very early versions of 

pH-MultiScan does not serve any purpose anymore and has consequently been 

removed. By doing so it has made it possible to raise the limitation of max 170 

scans with 4 plates and 227 scans with 3 plates to 251 scans with 1-4 plates.   

 


